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Chapter 1 - Introduction

Modern industries are using a wider variety of label products than ever before.  PAN-MARK 2.5 is designed to work in
tandem with the various label types and materials found in today’s marketplace.

Panduit offers computer printable labels for laser, ink jet, thermal transfer, and dot matrix desktop printers.  Labels are
designed to function in most desktop printers with your computer.

Laser and ink jet labels are supplied on US Letter Sheets which are 8.5” x 11” (215.9 mm x 279.4 mm) or on DIN A4
Sheets which are 8.27” x 11.69” (210 mm x 297 mm).

Thermal transfer labels are supplied on rolls and can be used with the Panduit PTR2E and PTR3E Thermal Transfer
printers or similar printers.

For more information on our computer printable labeling products, call 866-405-6658 or visit www.panduit.com.  For a
complete catalog of labeling solutions, request the PAN-CODE  Identification and Labeling Solutions catalog.
 

The Total Label Solution: PAN-MARK 2.5

Panduit introduced its label software, PAN-MARK 1.1 in 1988.  In today’s marketplace, sophisticated users demand
even more flexibility and power.  PAN-MARK 2.5 provides these increased capabilities, such as:

• Over 800 built-in label formats (Including laser, ink jet, thermal transfer and dot matrix)
• Several resident fonts included
• Several types of data can be placed on labels:

• Text
• Graphics
• Line Drawing
• Serialization
• Open Database Connectivity (ODBC)
• Date and time stamp
• Operator input
• Bar Codes

Hardware and Software Requirements

PAN-MARK 2.5 runs on any IBM compatible computer with a minimum configuration of:

• 486 processor recommended

• Eight megabytes of random-access memory (RAM).  Sixteen megabytes or more is recommended.

• Microsoft Windows 95, 98, Me, 2000,  Windows NT4.0, and Windows XP

• A hard disk with a minimum of 30 megabytes of free space
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Using Items to Create Labels

PAN-MARK 2.5 introduces a new concept in label design called items.  Items are “building blocks” you can use to
create a label as simple or as complex as you need.  Items are divided into two categories:

1) Static - Items that do not change from label to label, such as text, images, and lines

2) Dynamic  - Items that can change from label to label, such as:

• Serial numbers, based on user criteria
• Date, based on the current system date
• Time, based on the current system time
• ODBC Data based on an external database, such as Excel, dBASE, etc.
• Input, a user-defined prompt requiring an operator entry
• Bar codes

The simplest example would be to enter a single text itemsuch as an addressinto a label.

Therefore, this label uses only one building block.

Text Item

The following label uses several building blocks to insert a text item address, a line item divider, a serialized package
number, shipping date and time items, and a part number supplied from an ODBC database.

The building blocks for this label would look something like this:

Text Item

Line Item

Text Item

Text Item

Text Item

Serial Item

Date Item

ODBC Data Item

Time Item

  ABC Company
  123 Fourth Street
  Anywhere, USA   11111

  To:  ABC Company
         123 Fourth Street
         Anywhere, USA   11111
 _________________________________

   Package Number:  A101
   Shipped:  10-20-02  12:04 pm
   Part Number:  XYZ-1098
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You can combine items and arrange them in any order you choose.  You can even use an item more than once in a
label.  For example, two image and two line items are used in the following label.

This example shows an image item and a bar code item.  PAN-MARK includes 21 different bar code symbologies.  This
bar code is an example of the PDF 417 bar code. You can use the PDF 417 bar code to convey thousands of bits of
information.

     Panduit Label Products
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How This Manual is Organized

Information about PAN-MARK 2.5 is broken down into the following chapters:

Chapter 1 - Introduction
• What is PAN-MARK 2.5, and what type of computer hardware and software is required to use it.

Chapter 2 - Setup
• How to install PAN-MARK 2.5 on your system.

Chapter 3 - Exploring PAN-MARK 2.5
• Moving around in the program, using a mouse, using keyboard shortcut keys, and other useful information for using

PAN-MARK.

Chapter 4 - Creating Labels in PAN-MARK 2.5
• This section describes all PAN-MARK menus and commands.

Chapter 5 - Creating Wire Markers
• This section describes how to create specialized labels for wire applications.

Chapter 6 - Creating Pipe Markers
• This section describes how to create specialized labels for pipe applications.

Appendix
• List of electronic symbols contained in the PAN-MARK  image library

• List of bar code symbologies contained in the PAN-MARK  bar code library
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Chapter 2 - Setup

Before installing PAN-MARK 2.5:

• Close all other applications, including Microsoft Office.

• Make sure you have a minimum of 30 megabytes of free space on your hard disk.

Follow these steps sequentially to begin using PAN-MARK 2.5:

1. Install PAN-MARK for Windows.

2. Select your most often used formats.  Choose your favorite (or most often used) formats from the database so
they can be selected directly from a list in the label window.

Step 1: Installing PAN-MARK 2.5

Before you begin the installation process, take note of the PAN-MARK serial number that is located on the CD jacket.
You will be required to enter this serial number during installation.

Follow these steps to install PAN-MARK 2.5:

1. Insert PAN-MARK program CD in the CD drive.

2. Follow the on-screen instructions.

3. It is a good idea to view the README file after completing Setup.  The README file contains important last minute
notes and information about PAN-MARK 2.5.

PAN-MARK 2.5 is automatically added to Start | Programs.
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Step 2: Selecting Your Most Often Used Formats

Typically, you use certain label formats that fit your everyday needs.  Out of the hundreds of formats supplied by
Panduit, that may be only a few labels.

Instead of going through the entire database’s format list every time you want to make a selection, you can pick your
most often used formats, creating your own short list of “favorites” that will be available directly from the PAN-MARK
window.

To select your most often used formats:

1. While still in the PAN-MARK windowwith no files open, click Format in the menu bar, then click Select in the
drop-down menu.

A selection window appears, displaying a list of all the available label formats in the PAN-MARK formats database.

2. Scroll the list to the first label format you want to place in your favorites list, then click to select.

To select several consecutive formats at once:
• Press and hold the Shift key, then click two non-consecutive label formats, such as PDL-5 and PDL-8.

Formats PDL-6 and PDL-7 will also be selected

   Or 

• Click and drag the pointer over the desired formats.
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To select several non-consecutive formats at once:
• Press the Ctrl key, and then click the desired formats.

3. Click the Copy button to copy the selected format(s) to the right box.

4. When you complete your list, click OK to exit the selection window.

These formats are now available directly from the PAN-MARK window.
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Chapter 3 - Exploring PAN-MARK 2.5

This chapter familiarizes you with the working elements of PAN-MARK 2.5 and how to use them.  We’ll discuss:

• Moving around in PAN-MARK

• Using a mouse

• Using the keyboard

• Shortcut keys

• Dialog boxes and information windows

• Elements of a label

• Tool bars

• Information bars

• Scroll bars

• The menu bar

• The Help icon

• Customizing the PAN-MARK window



PAN-MARK 2.5

9

Moving Around in PAN-MARK 2.5

Like other windows-based products, PAN-MARK uses menus and dialog boxes to help you navigate through its menus
and commands.  In the following screen example,

• Commands appear in drop-down menus.

• Titles for drop-down menus appear in the horizontal bar under the window title.

• Tool bars show icons for commands you use most often.  Just click on the appropriate icon to implement a
command.  (The Tool bar icons are defined later in this section.)

Drop-down
    Menu

Menu Bar Tool Bars
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Grayed Menu Selections

Grayed menu selections are temporarily unavailable.  Certain menus or commands are available only after other
prerequisite activities are performed.

For example, in the Edit menu, the Cut, Copy, and Delete  commands are not available until an item is selected.

In the following label, PAN-MARK doesn’t know which item you want to cut, copy, or delete until you click to select it.

NOTE:  You cannot copy and paste ODBC items.

After you select the desired item, these edit commands become available.
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Using a Mouse

To select, move the mouse pointer to the desired menu or command, then press the left mouse button.  Pressing a
mouse button is also referred to as click  or clicking.

When selecting from a list, you may do either of the following:

• Click once on the list entry, and then click the confirmation button (such as OK).

• Double-click on the list entry.

Using the Right Mouse Button

When a label is open, you can click the right mouse button anywhere in the label window away from an item to display a
pop-up of the Item menu.

When a label item is selected, you can click the right mouse button to display a pop-up menu to choose item properties,
alignment, etc.  These pop-up menus display options related to the selected item.
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To illustrate, there are two items on this label: A text item (the address) and a graphic item (the Panduit logo). Select the
text item, and then click the right mouse button to pop up a menu specifically related to text items.

Select the graphic item and click the right mouse button to pop up a menu specifically related to graphic items.
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Using the Keyboard

To make a selection from the menu bar using the keyboard, press Alt plus the underlined character in the menu title.
For example, press Alt+F to open the File menu.

To make a selection from a drop-down menu, just press the key that corresponds to the underlined character in the
command.  For example, press the r key to select Print Setup in the File menu.
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Shortcut Keys

Shortcut keys can be used to quickly implement certain commandswithout having to open menus or use the mouse.
For example, you can open a label using either of the following methods:

Click File in the menu bar, and then click Open in the File menu
 Or 

Press Ctrl+O

In various examples throughout this User’s Guide, either the mouse or shortcut key method may be used for illustration.
After you become comfortable with both, you can use whichever method you prefer.
The following shortcut keys are available:

Ctrl+N Create a new label
Ctrl+O Access the Open Label dialog box
Ctrl+S Save the current label
Ctrl+P Print a label
Ctrl+X Cut text from a label
Ctrl+C Copy text in a label
Ctrl+V Paste text in a label
Del Delete marked text
Ctrl+F Select a typeface
Ctrl+G Access label properties
Ctrl+F4 Close the current label
F1 Help
F5 Refresh display or unselect an item
F7 (Size Contents) Minimize the selected label Item area

 or 
Restore a selected graphic to its original
size

Ctrl+ Zoom in
Ctrl- Zoom out
Ctrl+Shift+T Insert text
Ctrl+Shift+I Insert an image
Ctrl+Shift+L Insert a line
Ctrl+Shift+S Insert a numbering series
Ctrl+Shift+D Insert the current date
Ctrl+Shift+M Insert the time
Ctrl+Shift+A Insert ODBC data
Ctrl+Shift+N Insert operator input
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Dialog Boxes and Information Windows

Dialog boxes appear when you are asked to provide information or select from a list.

This dialog box provides listings and other useful assistance.

Information windows  may prompt you for action.
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The Control box is located in the upper left corner of all windows and dialog boxes.

To exit a dialog box, do one of the following:

• Click the Control-menu box
• Click the Cancel button

Control box
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Features of the Label Window

When working in a label, several PAN-MARK features are available.  Each of the numbered screen areas are defined in
the list which follows.

1. Click any of the topics in the Menu bar to display drop-down menus of related features.

2. The Horizontal tool bar provides “shortcuts” to some of the most-used features, such as:

• Standard features, such as opening, saving, and printing a label file
• Moving to the first, last, next, and previous label
• Aligning text in your label, such as centering or left-justifying
• Zooming out or in on a label

3. The Document bar displays the following information:

• The current document type, e.g., Label.  Currently, three document types are supported: Label, Wire Marker,
and Pipe Marker.  Other document types may be included in future releases

• The current format being used, such as label format PDL-19

• The current text font, such as Arial

• The current text attribute, such as Regular, Bold, Italic, etc.

• The current font size, such as 9 points

• The current label number

1 Menu bar 2 HorizontalTool 3 Document bar

4 Title bar

5 Label area
6 Label work area 7 Status bar

8 Item bar
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4. The Title bar of the label window displays the name of the current label.

5. The Label area, where you insert label items such as text, graphics, etc.

6. The Label work area (the label may or may not fill this entire area).  This can be enlarged using the Maximize
button (see number 6).

7. The Status bar displays the following information:

• An informational prompt for the current activity
• The label’s page number (there may be several pages of labels)
• The label’s row and column number
• The current label’s number, such as “1 of 10”
• The current label’s width and height measurements

8. In PAN-MARK, everything that goes on a labelsuch as text, graphics, or serialized numbersare items.  You can
use this vertical tool bar called the Items bar to quickly insert items in your labels.

Tool Bars

PAN-MARK has five tool bars to help you create labels more quickly and efficiently.

• The Standard bar
• The Movement bar
• The Alignment bar
• The Zoom bar
• The Items bar

The first four tool bars are located just under the menu bar.

  Zoom Bar Movement Bar
Standard Bar Alignment Bar



PAN-MARK 2.5

19

The Standard Bar

The Standard bar offers standard Windows features, such as opening, saving, and printing a label.

The Movement Bar

The Movement bar lets you move quickly within a label series.

Create a new label

Move to the
              first label

Open a label

                 Move to the
previous label

Save a label file

Move to the
              next label

Move to the
                    last label

Context-sensitive help

About PAN-MARK

Print a label

Paste an item in a label

Copy an item in a label

Cut an item from a label
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The Alignment Bar

The Alignment bar lets you quickly align your text within a label.

Align at left margin

Align at right margin

Align at top margin

Align at bottom margin

Center horizontally

Center vertically
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The Zoom Bar

The Zoom bar lets you adjust the size of your label while working within the label window.

Notes:

• These are on-screen adjustments only.  They do not affect the size of the printed label.
 
• Auto Fit is especially useful when working with larger label formats or roll mounted products

(Auto Fit) Automatically size a
label to fit within the label window

Zoom in on label
(Click again to zoom in

further)

Zoom out from label
(Click again to zoom further

away)

Return to normal view
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The Items bar

The fifth tool bar is displayed vertically along the right border of the
PAN-MARK window.

You can use this tool bar to quickly insert several types of label items.

Click this icon to activate the mouse pointer for selection

Click this icon to insert a text item into your label

Click this icon to insert horizontal or vertical lines into
your label

Click this icon to insert the current date into your label

Click this icon to insert the current time into your label

Click this icon to insert ODBC data into your label

Click this icon to insert a prompt requiring operator input

Click this icon to insert a graphic image into your label

Click this icon to insert series numbers into your label

Click this icon to insert a Bar Code
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Information Bars

PAN-MARK has two information bars to provide label information at a glance.

• The Status bar
• The Document bar

The Status Bar

The Status bar displays the following information (from left to right):

• An informational prompt for the current activity
• The label’s page number (there may be several pages of labels)
• The label’s row and column number
• The current label’s number
• The label’s width and height measurements

The Document Bar

The Document bar displays the following information (from left to right):

• The current document type, such as Label. Currently, three document types are supported: Label, Wire Marker, and
Pipe Marker.  Other document types may be included in future releases.

• The current label format.  To change the label format, click the arrow to display a drop-down list of available formats,
then click to select the new format.

• The current text font.  To change the text font, click the arrow to display a drop-down list of available fonts, then click
to select the new font.

• The current text attribute, such as Regular, Bold, Italic, etc.  To change the text attribute, click the arrow to display
a drop-down list of available attributes, then click to select the new attribute.

• The current font size. You can change the font size in either of two ways:

• Click the arrow to display a drop-down list of available font sizes, then click to select the new size.

• Click in the font box, then type the new size.

• The current label number.  If you have more than one label in a file, click in this last box on the Document bar, then
type a number to go to that label.  For example, type 8 and press the Enter key to go directly to label 8.



Exploring PAN-MARK 2.5

24

The Menu Bar

The menu bar displays the titles of the PAN-MARK menus.

These menu selections will vary depending on the following conditions:

• The type of document selected
• If no label is open
• If a label is open (as shown in the example above)

You click on a menu title to display a drop-down menu of related commands.  The following menu items are a composite
of all available selections.

Use the File menu to:

• Create new labels
• Open existing labels
• Close the label you are working in
• Save the label you are working in
• Save the current label as another file name
• Print the current label
• Preview the current label before printing
• Make temporary setup changes to the printer before printing
• Exit

Use the Edit menu to:

• Cut

• Copy

• Paste

• Delete items

Use the View menu to:

• Display/hide the individual tool bars

• Create a label on the fly with label text

• Display/hide the format layout facsimile in the label window

• Zoom in to view the detail on a label

The Format menu only displays before you open a label.  Use this menu to:

• Define a new label format

• Open an existing label format

• Select your most often used formats from a database

• Open an existing database

• Create a new database
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Use the Font menu to:

• Select or change a font and its attributes for the current label

• Select foreground and background colors for your label (if you have a color printer)

• Rotate text in the label

Use the Item menu to:

• Select static and dynamic items to place in your label.  Static items do not change from label to label, such as text,
graphic images, or lines.  Dynamic items can change from label to label, such as series numbers, date, time, data,
operator input and bar codes.

• Determine the properties of an item.  For example, the properties of a date item include its Display Range, Date
Format, etc.

Use the Layout menu to:
• Align

• Center

• Size items in your label.

Use the Label menu to:

• Determine label format properties, such as the dimensions and margin sizes for label format PDL-19

• Move to another label

• Insert a label into a series of labels

• Remove a label from a series of labels

• Enter a message you want to display to the operator before printing

Use the Options menu to:

• Choose your preferred label measurements (inches or millimeters)

• Turn the “Cut Here Mark” on or off  (This option applies only to
Pipe Markers)

• Select an ODBC database from the Administrator

• Design a database with the Designer

• Edit data in a database with the Editor

Use the Window menu to:

• Open a new window

• Select cascade or tile window arrangement

• Rearrange your icons when you have several labels minimized

Use the Help menu to find help for PAN-MARK.
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The Help Icon

The Help icon is located in the Standard tool bar.

Click the Help icon, drag the pointer to any part of the PAN-MARK window, and then click again on the desired button,
item, or field to display context-sensitive help.

Help Icon
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Customizing the PAN-MARK Window

The sample PAN-MARK windows you’ve seen thus far represent one view of how you can organize the items on the
window.  PAN-MARK features an “elastic” interface that means that you can drag and drop tool bars so that you can
customize the window.

To customize your PAN-MARK window:

1. Place your pointer at the edge of the box surrounding the tool bar you want to move.  For example, the Zoom bar.

2. Drag the tool bar to the desired location and release the mouse button.

The item appears where you placed it.
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Chapter 4 - Creating Labels in PAN-MARK 2.5

How This Chapter is Organized

This chapter describes how to use PAN-MARK menus and commands when creating labels.  It is divided into two parts:

• The main menus

• The command menus

The Main Menus

Before opening or creating a label in PAN-MARK, your menu choices display only the necessary functions, such as
opening a label file or choosing a label format.

Once the label is open, PAN-MARK provides a full complement of menu options for creating or editing.  (These options
will vary depending on the document type.)

Clicking a menu title in either menu bar displays a drop-down menu of related commands for that function.  The table on
the following page lists the commands available under each menu.
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The Command Menus

These drop-down menus display when you click on the corresponding title in the menu bar.  (Some menus appear before
or after a label is opened, depending on their function.)

File Menu

New
Open
Close
Save
Save As
Print
Print Preview
Print Setup
Exit

Format Menu

       New
Open
Select
Open Database

Edit Menu

Cut
Copy
Paste
Delete

View Menu

Toolbars
       Standard bar

Status bar
Document bar
Movement bar
Alignment bar
Items bar

       Zoom bar
Format layout

       Label text
       Zoom
               Auto Fit
               In
               Out
               Normal
       Refresh

Font Menu

Typeface
Color

Foreground
Background

       Rotate
              0
              90
              180
              270

Item Menu

Static
Text
Image
Line

Dynamic
Series
Date
Time
Data
Input

              Bar code
Properties

Layout Menu

Align
Left
Right
Top
Bottom

Center
Horizontal
Vertical
Both

Size
Width
Height
Both

Label Menu

Properties
Move To

First
Previous
Next
Last

       Insert
       Remove
       Operator
Prompt

Options Menu

Units
Inches
Millimeters

Cut Here Mark
       ODBC Admin
       ODBC Editor
       ODBC Designer

Window Menu

New Window
Cascade
Tile
Arrange Icons

Help Menu

Contents
       Index

Using Help
About PAN-

MARK

PAN-MARK
Menus

For easier reference, discussion of the PAN-MARK commands and features follows the general flow of these menus.

The explanation for each command is found under its respective menu heading.  For example, the Save command is
discussed in the File Menu section.
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File Menu

Use the File menu to:

• Create new labels

• Open existing labels

• Close a label file that you are working in

• Save a new or edited label to a file

• Save an existing label to a different file name

• Print labels

• Preview labels before printing

• Temporarily change the printer setup before printing

• Exit PAN-MARK

You must select a list of your favorite formats for the current document type before many of these File menu functions
will become available.  This procedure is explained in the section Selecting Your Most Often Used Formats in this
chapter.

Creating a New Label

Creating a new label is a three-step process:

• Select a document type, such as Label or Wire Marker.

• Select a format, such as PDL-1.

• Enter items such as text, images, or serial numbers into your label.

In PAN-MARK, you must choose a document type and label format in order to create your label.  These two selections
combine to determine the size of the label and the way items are positioned on the label.

When you initially enter PAN-MARK, you cannot select a new label until you choose a document type and format.
Each time you enter PAN-MARK again, the document type and format selections from your last label will be retained.
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Selecting a Document Type

Currently, there are three document types available in PAN-MARK:

• Label
• Wire Marker
• Pipe Marker

Label is the default document type displayed in the Document bar.  To change the document type:
1. Click the Document Type drop-down arrow.

2. Click Wire Marker in the drop-down list.

Now you’re ready to select a format for your label.

Click to display a list
of document types
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Selecting Your Most Often Used Formats

Note:  This step was performed when you initially installed PAN-MARK.  The only other times you will need to perform
this step is when:

• You change the default document type, e.g., Label to Wire Marker.
 Or 

• You want to add or remove formats from your list of selected formats.

Before you can select a format from the Document bar, you must do the following:

To select your most often usedor favoriteformats:

1. Click Format | Select.  A selection window displays.

2. Scroll in the list to a label format you want to select, then click the Copy button to copy this format to your favorites
list in the right box.

To select several consecutive formats at once:

• Press and hold the Shift key, then click two non-consecutive label formats, such as PDL-5 and PDL-8.
Formats PDL-6 and PDL-7 will also be selected.

    Or 

• Click and drag the pointer over the desired formats.
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To select several non-consecutive formats at once:

• Press the Ctrl key, and then click the desired formats.

3. Click the Copy button to copy the selected format(s) to the right box.

4. When you have completed your list, click OK to exit the selection window.

5. You can now access these selections from the Format field of the Document bar in the PAN-MARK main window.
Just display the drop-down list and choose the format you prefer.
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Selecting a Label Format

After creating your first label in PAN-MARK, all subsequent sessions automatically display a blank label using the last
document type and format from your previous session.  (Font attributes and tool bar selections are also retained.)

If this format is not the one you want to use in this session, click the drop-down arrow in the Formats box of the
Document bar the to display a list of your most often used formats.

From the drop-down menu, click the format you want to use for this label, such as JL-4. The new label format appears.

The formats displayed in this drop-down list were previously chosen from the PAN-MARK formats database.  This
procedure is explained in the previous section Selecting Your Most Often Used Formats.

Click to display a list
of your favorite
formats
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Entering Items into a Label

After selecting the document type and the label format, you are ready to select a new label and enter items.

To select a new label:

Click File | New

 Or 
Click the New Document icon in the Standard bar

A new label for the selected document type and format displays.

In this example, we will just enter a text item to illustrate the basics.  For more on entering text and other label items,
see the Item Menu section in this chapter.

To enter text in a label:

1. Click Item | Static | Text

 Or 
Press Ctrl+Shift+T

 Or 
Click the Text icon in the Items bar

2. Move the Text pointer into the label area.  As you enter the label area, the pointer changes to identify the type of
item you are working within this case, the Text icon pointer.
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3. Place the pointer where you want to insert your label text.

4. Click and drag to open a text entry area.  Give yourself as much room as you think you will needyou can shrink
the text area later.
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5.    Release the mouse button.  A text cursor now appears in the text entry area.  Now you’re ready to actually enter
your label text.

6. Type the text in the text entry area.
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7. After you finish entering text, click outside the item or press F5 to unselect.  The text box disappears.
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Opening an Existing Label File

At least one label file must exist before this option is active.  You can open an existing label in one of two ways:

• Click the file name of one of the most recently accessed files listed at the bottom of the File menu.
 
• Select a file from the listing displayed in the Open dialog box.

1. Click File | Open

    Or 
Click the Open icon in the Standard bar

2. In the Open dialog box, type the name of the file you want to open, such as MYFIRST.LBL

    Or 
Double-click on the file name.

Closing a Label File

1. Press Ctrl+S if you want to save the file.

2. Click File | Close

 Or 
Press Ctrl+F4.

Saving a Label File

This option appears on the File menu after a label is created or opened.

When working in a label, you can save your work at any time by:

Clicking File | Save

 Or 
Pressing Ctrl+S

 Or 
Clicking the Save  icon in the Standard tool bar.
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Saving a Label File as Another Filename

This option appears on the File menu after a label is created or opened.

Use the Save As option to:

• Assign a unique file name to a new label

• Save an existing file under another name, while leaving the original file intact.

To save a file under another name:

1. Click File | Save As.

2. Type the name you want to give the label file, such as MYFIRST.

PAN-MARK adds the appropriate file extension for you, based on the current document type.  For example:

• A label would be saved as MYFIRST.LBL
• A Wire Marker would be saved MYFIRST.WIR
• A Pipe Marker would be saved as MYFIRST.PIP

3. Click the OK button.

Deleting a Label File

To delete a label file, use Windows File Manager.

1. Close all label windows and exit PAN-MARK.

2. Open File Manager and go the directory you have assigned for your labels, such as \PMWIN21\LABELS.

3. Click on the label file(s) you want to delete.

4. Click File | Delete .
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Printing Labels

There are three options in the File menu related to printing:

• Print - Specify a print range, specify selected labels for printing, and other print-related functions

• Print Preview - View a graphic facsimile of how your labels (and their content) will display on label sheets

• Print Setup - Change printers, paper size, paper source, and other printer related functions

Printing Basic Labels

If a label contains a text item, add these initial steps:

1. Click the text item, and then press Ctrl+G.

2. Click the All radio button in the Display Range group of the Text Properties box, and then click OK.

To print basic labels:

1. From within the label file, press Ctrl+P.

2. In the Print Labels dialog box, type the number of labels you want to print in the To field.

3. Click the Print button.

More complex label printing situations are covered on the following pages.

The Print Labels Dialog Box

Clicking File | Print or pressing Ctrl+P opens the Print Labels dialog box.

Most of the options in this dialog box are self-explanatory.  However, the following options require clarification:

• Print Range
• Print Range Selection
• Features
• Align
• Print to File
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Print Range
You use options in the Print Range group to designate specific labels for printing.

Example 1: You have created one label and want to print 100 copies.  Type 100 in the To field.

Example 2: You have created a file of mailing labels for each of your 50 state headquarters.  Today you want to ship one
package to each headquarters office in states 10-20, just type the following entry:

Print Range Selection
You access the Print Label Selection dialog box by clicking Selection in the Print Range group.  Use this dialog box to
specify multiple print ranges.

In the previous Example 2, you sent a package to offices 10-20.  Today you need to send a package to the remaining
headquarters offices, plus an additional package to offices 40-50.  To print these specific labels:

1. Click Selection in the Print Range group.

2. Tab to the To field and type 9, then click the Add button.  The first part of your label selection displays in the
Ranges box.

3. Click in the From field and type 21, tab to the To field and type 50, then click the Add button.
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4. Click in the From field and type 40, then click the Add button.  Your entries should look like this:

5. If you wanted to change the order the ranges of labels would print, select the range you want to change and click
Move Up to move the range up in the list or Move Down to move it down.

For example, to move 1 copy per range of 40 through 50 up in the list, select it and click Move Up.

6. Click OK to close the Print Label Selection dialog box.

7. Click the Print button in the Print Labels dialog box to print these selected labels.



Creating Labels in PAN-MARK 2.5

44

Print Features
Click the Features button to access the Print Features dialog box.

Two print features are available from this dialog box:

Start at Label Position - Use this feature to use the remaining labels on a label sheet.  For example, if you have used the
first 15 labels on a 50-label sheet, type 16 as your starting position to use the rest of the label sheet.

Caution:  Some laser printers generate very high internal temperatures.  This may cause label adhesive to break down
when a label sheet is run through more than once.  As a result, labels may peel off inside the printer.

Top Origin, Left Origin - These two fields are used to adjust the printing offset for laser printers.  Different laser printers
require varying amounts of paper-handling area around the border of a label sheet (usually from 1/8” to 3/8”).

Tips on Positioning Label Data:

• If the data on your laser labels is positioned too high, enter a Top Origin value (such as .1) to move the data down on
the labels.  Raise this value to increase the offset.

 
• If the data on your laser labels is positioned too far to the left, enter a Left Origin value (such as .1) to move the data

to the right.  Raise this value to increase the offset.
 
• Enter negative values (such as -.1) to decrease the offset and move the data in the opposite direction.

Print Align
Click the Align button to print an alignment sheet.  Use this alignment sheet as a template for making any necessary
printer adjustments before printing.

PAN-MARK will print anywhere from one row to a full page of labels, depending on the type of format and printer driver
selected.
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Print to File
Use this option if you need to print labels on a computer terminal or workstation that does not have PAN-MARK for
Windows, such as a warehouse or remote location.  You can print the labels to a file on a diskette, then insert the
diskette at the remote terminal and print the labels on the workstation’s printer.

To print to a file:

1. Press Ctrl+P, then click the Print to File check box in the Print Labels dialog box.

2. Click the Print button, then enter the file name, such as MYLABELS.PRN.

3. Choose the floppy drive or directory where you want the file to print, then click the OK button.
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The Print Preview Option

Click File | Print Preview to view a graphic facsimile of how your labels (and their content) will display on label sheets.

Print Preview will only display the label(s) contained in a label file.

Example 1: A single label in a file

You have created the file ABC-MAIL.LBL containing this single label and want to print 100 of these labels to ship 100
packages to ABC Company.

If you preview this print job, only one label displays because it is the only label in the file.  The other 99 labels will be
copies of this label, produced during the print run.

Example 2: Several labels in a file

However, you have created another file called DISTRICT.LBL that contains 100 separate labels (two of which are shown
below).  Each of the 100 labels has a different address for a specific district office.

When you preview this print job, all 100 labels will display because there actually are 100 separate labels in the file.

 ABC Company
 123 Fourth Street
 Anywhere, USA   11111

 ABC Company
 District Office #1
 222 Second Street
 Lotsarain, WA   22222

 ABC Company
 District Office #2
 999 Ninth Street
 Hotspot, AZ  99999
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Special Considerations When Previewing Dot-Matrix and Thermal Labels

PAN-MARK previews (and prints) Dot-Matrix labels by row, which allows you to conserve your labels.  To do
this, PAN-MARK treats each row as a “page.”

For example, let’s say you want to print four labels on a sheet that contains six rows of labels with four labels
in each row.  PAN-MARK will only print a row at a time.

If you wanted to print another four labels at a later time, you can use the same label sheet, advancing the
sheet to the next row.

However, Windows Dot-Matrix printer drivers cannot recognize a printer page with a vertical measurement of
less than one inch.  This can cause Dot-Matrix labels with repeat factors smaller than one inch to print or
preview incorrectly, with a single row wrapping to the next row.

Laser and thermal labels preview and print by label sheet and do not experience this anomaly.

The Print Setup Option

To open the Print Setup dialog box:

Click File | Print Setup

 Or 
Click the Setup button in the Print Labels dialog box

Use this dialog box to:

• Change the default printer

• Select a specific printer for this label run

• Change paper orientation, paper size, or paper source

• Access printer options (these options will vary, depending on the selected printer)

Tip:  If some of your label data is missing, check the paper size.  An incorrect paper size setting can result in clipped
labels.
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Format Menu

The Format menu is only available before you create a new label or open an existing label.

Use the Format menu to:

• Create a new label format

• Open an existing format for viewing or editing  (Only unprotected label formats can be edited.  Some PAN-MARK
labels are protected and cannot be modified.)

• Select your most often used formats

Creating a New Label Format

In addition to the label formats provided by PAN-MARK, you can create your own custom formats.  These new formats
are entered into the Format Properties dialog box.

Format properties are divided among six panels, which are listed in the Panel menu (shown above).  Each of these
panels is discussed as you create a new label format in the following exercise.

To create a new label format:

1. Close all open labels.

2. Click Format | New to display the Format Properties dialog box.

Panel
Menu
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Entering Label Size Information

To enter the format name, label dimensions, and margin sizes in the Size Information panel:

1. Type the new format name, such as ADDRESS1.

2. Type the appropriate information for your new label format as shown in the following example.

Thermal Label Size Information
Label formats set up for continuous thermal tape require only Page, Label, and Repeat field entries.  The rest of the
format entries are optional.
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The Corner Field

If you are creating a format for a label with rounded corners, you may need to enter a value that indents the text enough
to prevent it from printing outside the rounded corner, or too close to it.

A higher corner value indents the text further.  For example, you might enter a value of .02 for the label on the left, and a
value of .05 for the label on the right.

.02 .05

(These label illustrations and corner values are exaggerated to make a point, and are not true to scale.)

Entering General Label Information

The General Information panel is used to enter the label description, the type of label cut, the protect mode status, and
user data required to access protected label formats.   To enter this information for your new format:

1. Access the General Information panel by clicking General Info in the Panel menu.

2. Type information as shown in the following example:
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The General Information fields are defined as follows:

Description This is a free-form field.  You can enter whatever text
you want to describe your label.

Cut Choose the type of label cut: Butt or Die  (Examples of
these label types are shown on the following page.)

Protect Mode No   = Unprotected label

Yes = Protected label

User Name If Protect Mode = Yes, type the User name required for
label access

Password If Protect Mode = Yes, type the password required for
label access.

Use a unique password, but one that you won’t forget.

These examples illustrate the difference between Die Cut and Butt Cut labels (as they might appear on a label sheet).

    Die Cut                       Butt Cut
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Entering Document Information

The Document Info panel is used to specify the document type(s) for a format.  To enter document type information:

1. Click Document Info in the Panel menu.

2. Click the appropriate check box to select Label, Wire Marker, or Pipe Marker as the correct document type(s) for
this format.  If a format is used for more than one document type, click the appropriate check boxes.
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Entering Font Information

The Font Info panel is used to specify the typeface, style, and point size for a format.  To enter font information:

1. Click Font Info in the Panel menu.

2. Enter (or select from the drop-down lists) the desired typeface, style, and point size for the font you want to use with
this label format.

3. To specify this font as the default for this label format, click the Default Label Font check box.
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Entering the Type of Printer

The Printer Info panel is used to select the type of printer this label is designed for, such as Dot Matrix, Laser, or
Thermal.

1. Click Printer Info in the Panel menu.

2. Click the appropriate radio button to select the type of printer to be used with this label format.  (Depending on your
version of software, this screen may appear differently.)

If you are using a PTR2E or PTR3E thermal transfer printer, you can permanently change driver settings through the
Control Panel.
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Previewing the Label Format

Click Preview in the Panel menu to see how labels using this format will fit on a label sheet.  By previewing, you can
verify whether your label specifications are valid (e.g., too large for the sheet).
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Opening an Existing Label Format

Use this Format menu option to open existing PAN-MARK formats or custom formats you have created.  You can then:

• View the format’s properties
• Edit the format if it is not protected

If format property information displays in gray (as it will for some PAN-MARK labels), it means the format is protected
and cannot be edited.

Protected formats may only be edited if protection is removed.  Entering a valid password in the General Information
panel, then clicking the No radio button for Protect Mode does this.

To open an existing format:

1. Close all open labels.

2. Click Format | Open.  The Format Properties dialog box displays.

3. To select a different format, click the arrow in the Format Name field to display a drop-down list.

Note:  The list includes only the most often used formats you have previously selected.

To add more formats to this drop-down list, refer to the section Selecting Your Most Often Used Formats in this
chapter.

4. Click the desired format to display its properties.

5. Click in the Panel menu to view other related information for this format.  For more information about these panels,
refer to the section Creating a New Format in this chapter.
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Editing a Label Format

Only unprotected labels can be edited.  To edit an unprotected format:

1. Close all open labels.
2. Click Format | Open to display the Format Properties dialog box, then follow the procedures in the previous section

Creating a New Label Format.

Updating a Custom Label Format in the Database

1. To update a change to an unprotected label format, click the Update button in the Format Properties window.

If the format is updated successfully, a confirmation message displays.

2. Click the OK button.

Deleting a Label Format from the Database

1. To delete an unprotected label format, click the Delete button in the Format Properties box.

If the format is successfully deleted from the database, a confirmation message displays.

2. Click the OK button.
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Selecting A New Format for Your “Favorites” List

When you initially installed PAN-MARK, you selected a list of your most often used formats.  If you have just created a
new format, you may want to add it to the list.

In this example, you will add MY_FORMAT to your selection list in the PAN-MARK window.

1. Close all open labels.

2. Click Format | Select.  The selection window displays.

3. Scroll to ADDRESS1 in the list, then click to select.

4. Click the Copy button to copy ADRESS1 to the Your Formats box, then click OK to exit the selection window.

5. You can now select ADDRESS1 from the Format list of the Document bar in the PAN-MARK main window.
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Edit Menu

Use the Edit menu to:
• Temporarily remove (cut) an item from a label

• Copy items within a label, or to other labels

• Paste copied or cut items in a label, or to other labels

• Delete items from a label

• Refresh the label

NOTE:  You cannot cut, copy, or paste ODBC items.

Removing an Item from a Label

Use the Cut command to temporarily remove an item from a location in a label to paste the item in another location on
the label.

To cut an item from a label:

1. Place the mouse pointer on the item and click to select.

2. Click Edit | Cut

 Or 
Press Ctrl+X to remove the item from the label
 Or 
Click the Cut icon in the Standard tool bar.
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Copying an Item in a Label

Use the Copy command to copy an item to another location in the label, or copy to another label.

To copy an item in a label:

1. Place the mouse pointer on the item and click to select.

2. Click Edit | Copy

 Or 
Press Ctrl+C

 Or 
Click the Copy icon in the Standard tool bar.

3. Click Edit | Paste or press Ctrl+V.  A duplicate item now displays, slightly offset from the original.

4. Place the mouse pointer in the duplicate item, then click and drag it to the desired location.
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Copying in PAN-MARK 2.5

The term copy is used in different ways in PAN-MARK.  For example, you can:

• Copy (or duplicate) items in a label as illustrated in the previous section Copying an Item in a Label.

• Create one label in a file, and then print 100 copies of it.  (This topic is covered in the section Printing Labels in
this chapter)

• Create copies of a label within a label file (This topic is covered in the section Creating Copies of a Label Within
a Label File found in the chapter Some Typical Label Examples)

Pasting an Item into a Label

If an item has been cut or copied, use the Paste command to insert the item into the label in another location, or into
another label.

1. To paste an item into a label:

Click Edit | Paste

 Or 
Press Ctrl+V

 Or 
Click the Paste icon in the Standard tool bar.

2. Place the mouse pointer in the pasted item, then click and drag it to the desired location.

Deleting an Item from a Label

Use the Del command to permanently remove an item from a label.

CAUTION:  If you delete an item, you cannot use the Paste command to recover it.

1. Place the mouse pointer on the item and click to select.

2. Click Edit | Delete

 Or 
Press Del

The item is permanently removed from the label.
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View Menu

Click a selection in the View menu to turn on/turn off the display in the PAN-MARK window for the following:

• Standard bar        

• Status bar  

• Document bar     

• Movement bar     

• Alignment bar     

• Items bar

• Zoom bar

• Format layout

• Refresh the View

Format
layout
display
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Using Label Text Mode to create a label on the fly

If you are going to have different text on each label, you can use Label Text.  You can enter your legend and use Page
Down to advance to the next label.

To use Label Text:

1. Choose the type of label you want to create.

2. Click File | New.

A new label appears.

NOTE:  When using Label Text, all of your item functions are unavailable.  Label Text mode cannot be used with other
item functions.

3. Click View | Label Text.

4. Place the pointer where you want the text and begin typing.  You can press Page Down to go to the next label.

5. Select Layout and choose Center, Left, or Right to align the text.
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Using the Zoom Options

You can use the Zoom options in the View Menu to adjust the size of your label while working within the label window.
(You can also use the Zoom bar in the tool bar to perform these functions.)

Note:  These are on-screen adjustments only.  They do not affect the size of the printed label.

To use the Zoom options:

1. Click View | Zoom

 Or 
Press Alt+V, then click Zoom in the drop-down menu.

2. Then click one of these options to perform the desired task:

Auto Fit  - Automatically sizes the label to fit within the label window

In          - Zooms in on the label.  Repeat to zoom in further

Out       - Zooms away from the label. Repeat to zoom further out

Normal   - Returns to normal view

Refreshing a View of a Label

Occasionally when working in a labelusually when you are working with more than one image itemyou may see
some graphic “litter” on the screen.  For example, if you move an image from one location to another on the label, some
portions of the image may appear to remain at the old location.  To remove the remnants of the old image:

Click Edit | Refresh

 Or 
Press F5

Font Menu

Use the Font menu to:

• Select a font style (typeface) for your label, and any attributes you want to use, such as bold, italics, etc.

• Select a foreground and background color for your label fonts (if you have a color printer)

• Rotate text in a label

Choosing a Font Style

To use a particular font style for text, serial numbers, time and date, or inserted data, use the Typeface command.  To
select a font:

1. Click Font | Typeface
2. The Font dialog box displays.  Select the font and any attributes you want to use in your label.
3. Click the OK button.
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Choosing a Foreground or Background Color

If you have a color printer, you can also specify foreground and background colors for your labels.

To select a foreground or background color:

1. Click Font | Color.

2. Click Foreground or Background.

3. Select a basic color from the color palette, or define a custom color.

4. Click OK.

Rotating Text in a Label

To rotate text in a label:

1. Select the text item to be rotated.

2. Click Font | Rotate.

3. Click the degree of rotation you want, such as 90.

Item Menu

Use the Item menu to:

• Enter items into your labels
• View or change the properties of a label item

Working with Items

Items are the building blocks of your labels.  They are divided into two categories:

• Static - Items that do not change from label to label, such as text, images, and lines

• Dynamic - Items that can change from label to label, such as:

• Serial numbers, based on user criteria
• Date, based on the current system date
• Time, based on the current system time
• ODBC Data based on an external database, such as Excel, dBASE, etc.
• Input, a user-defined prompt requiring an operator entry
• Bar code



Creating Labels in PAN-MARK 2.5

66

Selecting and Placing Items in a Label

You can select items using any of the following methods:

• Click Item in the menu bar to display the Item menu, then select the item

• Click the right mouse button to display the Item menu, then select the item

• Click the item in the Items bar, optionally displayed in the right border of the PAN-MARK window

When you select an item and move the mouse pointer into the label area, the pointer changes to reflect the selected
icon.  For example, the Text pointer looks like this when moved into the label area:

Everything you place on a PAN-MARK label is an item.  For example, there are two items in the following label: a text
item and an image item.

Each item can be selected separately (indicated by the shadow boxes).  Selected items can be copied, moved, or
deleted.

Caution About Overlapping Items

If you have trouble selecting an item on a label, it’s likely that another item’s area is covering it.  For example, the
following label contains a text item and an image item.  You try to select the image item, but can’t.
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By selecting the text item, you can see that the text item’s area actually covers the image item.  Therefore, when you
try to select the image, you can’t get to it and inadvertently select the text item.

To solve this problem, press F7 to reduce the text item’s area.  This should expose part of the image item so you can
select it.

Now you can easily select the image.

Tip:  To prevent this situation, always press F7 to reduce an item’s area after you have finished defining the item.

Moving Items in a Label

Click to select the item you want to move, then drag it to the new location and release the mouse button.  Move the
pointer to an open area in the label and click again to unselect the item.

You can also use the arrow keys for movement and fine-tuning the placement of an item.

Click on the
exposed area
of the image
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Resizing an Item

Graphic items (images and lines) can be enlarged or reduced to fit a particular label situation.  To size an item:

1. Click the graphic item to select it.  Eight “handles” appear around the shaded box.

2. Click and hold the left mouse button on one of these handles.   Drag the handle until the item area is the size you
want the graphic to be.

Handles
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3. Release the mouse button.  The graphic enlarges to fill the dragged area.  Click outside the graphic to remove the
handles.

Entering Text into a Label

Entering text in a PAN-MARK label is a two-step process:

• Insert a text item
• Type your text in the text entry area

To enter text in a label:

1. Open a new or existing label, and then do one of the following:

• Click Item | Static | Text
• Press Ctrl+Shift+T
• Click the Text icon in the Items bar
• Click the right mouse button, then click Text in the pop-up menu

2. Move the Text pointer into the label area.  As you enter the label area, the pointer changes to identify the type of
item you are working within this case, the Text icon pointer.
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3. Place the pointer where you want to insert your label text.

4. Click and drag to open a text box.  Give yourself as much room as you think you will needyou can shrink the text
area later.

5. Release the mouse button.  A text cursor appears in the text entry area.
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6. Type text in the label area.

7. Press F7 to shrink the text area and free up any unused space for other items you may want to insert in the label.
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8. If you are satisfied with the position of the text on the label, press F5 or click outside the selected area to unselect.

Justifying Text

In PAN-MARK, you can left-justify, right-justify, or center text horizontally.  (Left justified is the default.)

When justifying text in a label, it is important to remember the difference between the text item area and the label area.

• The text item area is the area you drag open with the Text icon before entering text.  A lined, shaded box surrounds
this area.

• The label area is the dimension of the label.  The text item area may or may not fill the label area, depending on the
size you choose when you drag the Text icon.

When you justify text, it is justified within the text item areanot the label area.

Centering Text in a Label

Centering text is actually a two-step process:

• First, you center the text in the text item area
• Then you center the text item in the label area

Label area

Text item area
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For example, to center the text in the following label:

1. Double-click the text item.

2. Press Ctrl+G.   The Text Properties box displays.

3. In the Text Alignment group, click the Center radio button, and then click the OK button.  Your text is now centered
in the text item area.

Next, you need to center the text item in the label.
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4. Click the Center Vertically icon in the Alignment bar, and then click the Center Horizontally icon.

5. The text is now centered on the label.

6. Press F5 to unselect.

Inserting an Image into a Label

PAN-MARK includes an image library of common electrical, safety, and data-comm symbols.  Additionally, you can
import bitmap image (.bmp) files, such as company logos into your label.

To place an image in a label:

1. Open a new or existing label, then do one of the following:

• Click Item | Static | Image
• Press Ctrl+Shift+I
• Click the Image icon in the Items bar
• Click the right mouse button, then click Image in the pop-up menu

Use these two
icons to center
the text item
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2. Move the Image pointer into the label area. Place the pointer where you want to insert your graphic.

3. Drag open a box for the image size you want, then release the mouse button.

The Image Properties dialog box displays.
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For a discussion of display ranges, see Item Display Ranges in the section Viewing or Changing Item
Properties in this chapter.

4. Click the Image File drop-down arrow and select an image from the list.  The selected image displays in the Preview
area.

NOTE:  You can rotate, flip, or invert the color of the image by selecting options on the right side of the dialog box.
When you click an option, the results are displayed in the preview area, e.g., a 90-degree rotation.

5. Click the Create  button to insert the image into the label.

6. Move the pointer outside the label, then click to unselect the image.
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Importing a Graphic Image

To insert an image not contained in the list, follow the same steps as mentioned above to open an image item.
1. At the Image Properties dialog box, scroll to the end of the image library list and select Load Custom Image.

2. Choose the directory and file name for your custom image.  (Remember - PAN-MARK will only import .bmp file
type.)

3. Select Open, then Create  and the .bmp image is inserted in your label.
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Using the Line Item

You can insert vertical or horizontal lines in your label for emphasis, or to divide areas.  For example, the following label
is functional, but you want something more.

To enter a line into a label:

1. Open a new or existing label, then do one of the following:

• Click Item | Static | Line
• Press Ctrl+Shift+L
• Click the Line icon in the Items bar
• Click the right mouse button, then click Line in the pop-up menu

2. Place the pointer where you want to insert your line.
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3. Drag until the line is the size you want, then release the mouse button.

Tip:  You can vary the width (or thickness) of the horizontal line by moving the pointer up or down.  You can vary the
width of a vertical line by moving the pointer left or right.

After releasing the mouse button, the line handles display.

4. Move the pointer away from the line, then press F5 or click to unselect.  You have now drawn a line using the line
item.
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Using the Series Item

Follow these steps to insert a serialization into your labels:

1. Open a new or existing label, then do one of the following:

• Click Item | Dynamic | Series
• Press Ctrl+Shift+S
• Click the Series icon in the Items bar
• Click the right mouse button, then click Series in the pop-up menu

2. Move the Series pointer into the label area.  Place the pointer where you want to insert the serial number.

3. Drag the handle until the Series item area is the size you want.
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4. Release the mouse button.  The Series Properties dialog box displays.

5.  Define your serialization.  Enter the Start Value , Stop Value , Step Value (if series is in increments), and the
number of Copies needed.

Here is additional information of some of the other features of the Series Properties dialog box:
Display Range
• Click the All option to display this serial numbering on all labels.  (This is the default setting.)
• Click Range, then type the appropriate values in the From and To fields to create serial numbers only on a

specific range of labels within a label run, such as labels 1-10 of 100 labels.
• Click Prompt Operator to prompt the person printing the labels for an entry.  For example, if your company

tracks used serial numbers, the operator would enter the next available number.

Static Text
• In Begin String, type a series prefix (such as A) to create a series like this:

A1
A2
A3

        The A is constant, and will appear before the serialization on every label.
• In End String, type a series suffix (such as A) to create a series like this:

1A
2A
3A

         The A is constant, and will appear after the serialization on every label.
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6. For this example, enter these values in the Series Properties dialog box:

Start Value 1
Stop Value 10
Begin String A

7. Click the Create  button to close the dialog box.

If you need to revise or correct a series number, just double-click on the series item to access the Series Properties
box again.

When the labels are printed, the first two labels of the serialization will look like this:

Using the Date Item

You can print the current date (based on your computer’s date calendar) on your labels by inserting a Date item.

If you use this feature, make sure your computer’s date calendar is set correctly.  You can change system date and
time in the Windows Control Panel.  Refer to your Windows documentation for this procedure if necessary.

To enter a date into a label:

1. Open a new or existing label, then do one of the following:

• Click Item | Dynamic | Date
• Press Ctrl+Shift+D
• Click the Date icon in the Items bar
• Click the right mouse button, then click Date in the pop-up menu

2. Move the Date pointer into the label area.  Place the pointer where you want to insert the date.

 ABC Company
 123 Fourth Street
 Anywhere, USA   11111

                   Package #       A1

 ABC Company
 123 Fourth Street
 Anywhere, USA   11111

                   Package #        A2
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3. Drag the handle until the item area is the size you want.

4. Release the mouse button.  The Date Properties dialog box displays.

5. Click the appropriate buttons in the Date Format group that correspond to the date format you want.

For example, to create the date format for 8-15-96 (the actual date depends on your computer’s calendar), click
these buttons:

Month: 1-12
Separator: Dash
Day of the month: 1-31
Separator: Dash
Year: 95
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As you click the buttons, the date is assembled in the Date group.  If you make a mistake, or want to make a
change, click the <<< button to erase an entry.

For a discussion of display ranges, see Item Display Ranges in the section Viewing or Changing Item
Properties in this chapter.

6. In the Get Date group, click:

• At 1st Label if you want all labels to print the date the first label was printed

• At Each Label if you want each label to reflect the actual date it was printed.  For example, if a print run was
initiated before midnight and finished after midnight, all labels printed after midnight would reflect the next day’s
date.

7. After you have constructed your date format, click OK.
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8. The date item displays. If necessary, adjust the placement of the date item, then press F5 or click outside the item
to unselect.

When these labels are printed, the current date will print at the designated location.

Using the Time Item

You can print the current time (based on your computer’s clock) on your labels by inserting a Time item.  If you use this
feature, make sure that your computer clock is set correctly.

To enter the current time into a label:

1. Open a new or existing label, then do one of the following:

• Click Item | Dynamic | Time
• Press Ctrl+Shift+M
• Click the Time icon in the Items bar
• Click the right mouse button, then click Time in the pop-up menu

 ABC Company
 123 Fourth Street
 Anywhere, USA   11111

                          April 21 1998
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2. Move the Time pointer into the label area.  Place the pointer where you want to insert the current time.

3. Drag the handle until the item area is the size you want.
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4. Release the mouse button.  The Time Properties dialog box displays.

5. Click the appropriate buttons in the Time Format group that correspond to the time format you want.

For example, to create the time format for 9:43 AM (the actual time depends on your computer’s clock), click these
buttons:

Hour 0-12: 0-12
Separator: Colon
Minute: 00-59
Separator: Space
Hour 0-12: am/pm

As you click the buttons, the time is assembled in the Time group.  If you make a mistake, or want to make a
change, click the <<< button to erase an entry.

For a discussion of display ranges, see Item Display Ranges in the section Viewing or Changing Item
Properties in this chapter.
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6. In the Get Time group, click:

• At 1st Label if you want all labels to print the time the first label was printed

• At Each Label if you want each label to reflect the actual time it was printed

7. After you have constructed your time format, click OK.

8. The time item displays.  (If you checked Brackets in the Options menu, the time will display inside brackets.)  If
necessary, adjust the placement of the time item, then press F5 or click outside the item to unselect.

When these labels are printed, the current time will print at the designated location.

 ABC Company
 123 Fourth Street
 Anywhere, USA   11111

                                       12:31 PM
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Using the ODBC Data Item

You can insert “external” data into your labels from sources outside PAN-MARK.

Using the Windows Open DataBase Connectivity (ODBC) interface, you can link to information created in other
electronic databases such as Excel or Access - and insert this information into your labels as an ODBC item.  You will
be using the ODBC drivers that are resident on your computer, and must have an ODBC driver for the application in order
to be able to import into PAN-MARK via ODBC.

There are 2 phases to importing from another database into PAN-MARK:
1. Using the ODBC Administrator to “link” the existing file into PAN-MARK.
2. Using the ODBC Data Item to specify the database “link” to be used, the specific fields you want, and other

necessary parameters.

The following example will walk you through both of these phases.  We will import an Excel (.xls) file into PAN-MARK.

IMPORTANT NOTE: When creating a file in Excel that you will be importing into PAN-MARK, it is necessary to
first format the cells as text.  To do this, highlight the entire sheet, select Format | Cells and click Text.  This

step will insure that the data is imported onto the label as it is entered in Excel.

To import an existing Excel file into PAN-MARK, follow these steps:
1. With the Excel program closed, in PAN-MARK close any open label files.  You should have a gray screen and your

icons will not be active.  Make sure that your are in Label Mode.
2. Click on Options | ODBC Administrator.  The ODBC Data Source Administrator dialog will appear.
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3. Click on the Add button located on the right side of the box.  The Create New Data Source box will appear.

On this screen, you will need to double-click on the type of driver you will be using.  For our example, we will use the
Microsoft Excel driver.

4. When you double click the Excel Driver, the Microsoft Excel Setup dialog box appears.

At this step, we are locating the directory that contains the Excel file.  To begin, click the Select Workbook button.
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5. The Select Workbook dialog box will appear.  Browse until you locate the Excel file you wish to import.            (Your
location will vary, depending on the drive and location you saved your Excel file.

6. Once your file is designated, click OK and you are returned to the Microsoft Excel Setup box.  Enter a name for
your date source or “link” at the Data Source Name prompt.  (It is helpful to assign a name to the data source that is
similar to that of the Excel file to avoid confusion.)

7. Click OK until you return to the PAN-MARK window.

Your data source is now created.  The next step is to bring the file into the label format.

8. From the PAN-MARK window, select the label format you will be using from the drop-down box.
9. Click on File | New to open a new label file.
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10. Click on the ODBC Data Item icon from the Items Bar and move the pointer into the label design area.

11. Click in the label design area, then release the mouse button.

12. The ODBC Database Properties dialog box will appear.

As you can see, there are many fields.  We will not use each of these properties, and will not discuss them in depth.
For more information about ODBC properties, refer to your specific database’s documentation.
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13. From the ODBC Database Properties dialog box, click on the drop-down box under Database Source until you
locate your data source name.  In our example, Wire Labels Link.

14. Once your data source is selected, you will notice that sheet/table names and column headings specific to your file
will fill in the properties box.  From the Excel file, all of the column headings appear in the Select <field> drop-down
box.  You can select as many, or as few, of the columns to be brought over into your labels as needed.  Once you
highlight a column heading that you want to import, click on the Add button.  In order to properly import the
information contained in the columns, make sure to add the columns in the order that you want them to appear on
your label.

NOTE:  If you would like to add all of the columns in sequential order, you can add them all at once by selecting the “*”
symbol.  This symbol is located at the end of list in the drop-down menu.

15. When you have selected all of the needed columns, click the Layout button on the right side of the ODBC Properties
box.  The ODBC Item Format Properties box appears.  Now you’re ready to define the format of how the text will
appear on the label.

NOTE:  If you want to use the default layout of one field per line, instead of choosing Layout, click OK.   Your
information is imported as specified.
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16. In the ODBC Item Format Properties box, your added column headings appear in the lower left panel.

17. To add Column 1 data into the label, select the Next Field button on the upper left portion of the dialog box.  Column
1 will now move up into the Format area.

Use the Separator actions to customize how the data appears on the label.  You can add commas, move to the
next line, add a space, or add a tab to insert 5 spaces.  Use the Other field to add a word or any other piece of
information between columns of data.  Click the Insert button to add anything entered in the Other field.

Continue this until you have inserted all of your columns of data and there are no remaining headers under Next Field.

For the following example, the columns are separated by a hyphen.

Column headings
appear in the order
in which they were

added
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18. When you have completed defining your label layout, click OK at the ODBC Item Format Properties box and again
at the ODBC Database Properties dialog box.  Your information has now been imported, and will be appear on the
label per your specifications.

If you need to make any modifications to the ODBC Item, you can double-click on the item to bring up the ODBC
Database Properties.

Tip:  If you need to know how many labels to print, select the Total button from the ODBC Database
Properties.  It will automatically calculate the number of labels created.
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Using the Operator Input Item

You can set up a label or labels to accept an input item just prior to printing.

For example, ABC Company places a large number of last-minute orders with your firm, and their Receiving Department
wants the part numbers displayed on the shipping label.

Since ABC is a frequent customer, you have already created a permanent address label for them.  For even greater
efficiency, however, you want to be able to enter a part number on the label just before printing.

To insert input into a label:

1. Open a new or existing label, then do one of the following:

• Click Item | Dynamic | Input
• Press Ctrl+Shift+N
• Click the Input icon in the Items bar
• Click the right mouse button, then click Input in the pop-up menu

2. Move the Input pointer into the label area.  Place the pointer where you want the input to appear.
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3. Drag the handle until the input area is the size you want.

4. Release the mouse button.  The Input Properties dialog box displays.
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5. In the Prompt field, type the instruction you want to appear on the screen at print time, such as Enter Part
Number.

6. Enter the field length for the input (in this case, the largest part number that might be typed in).  The default is 10
characters.

For a discussion of display ranges, see Item Display Ranges in the section Viewing or Changing Item
Properties in this chapter.

7. In the Get Input group, click:

• At 1st Label if you want all labels to print the same input as the first label, such as the same part number for 10
labels

• At Each Label if you want each label to prompt for a different input.  For example, if you were shipping 10
boxes of parts to a customerand each box contained a different part numberyou could enter the appropriate
part number for each label

8. Make any other appropriate selections, then click the Create button.

9. A series of XXX’s displays as a symbol of the input item.  (If you checked Brackets in the Options menu, the XXX’s
will display inside brackets.)  If necessary, adjust the placement of the input item, then press F5 or click outside the
item to unselect.
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When an operator attempts to print these labels, the prompt Enter Part Number will appear on the screen,
requesting the necessary input.  The operator then types the input, such as A2304.

NOTE:  The input item is not displayed.

The operator input will print on the label(s) at the symbol location.  For example:

 ABC Company
 123 Fourth Street
 Anywhere, USA   11111

             Part #          A2304
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Viewing or Changing Item Properties

When you create an item (such as a Series item, a Date item, etc.), you enter specific parameters in that item’s
properties dialog box.

To recall an item’s dialog box for viewing or changing these properties:

1. Click to select the item.

2. Click Item | Properties

 Or 
Press Ctrl+G

 Or 
Click the right mouse button, then click Properties in the pop-up menu

Each item’s properties dialog box is discussed in its respective section.

Entering Item Display Ranges

You can enter display ranges for all items.  For example, you may want to display one item on all labelsand a second
item only on certain labels.

All properties dialog boxes allow you to specify a display range for printing a selected property.

Example 1:  You have created two text items for a label and want both items to print on all 10 copies of a label run.

Follow the normal printing procedure for these labels.

1. Click File | Print.

2. Click the To field of the Print Range group of the Print Labels dialog box and type 10.
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Example 2:  You want to print the first text item on all ten labels, and the second label item only on the first five labels.
This scenario requires a few additional steps.

1. Click to select the second text item.

2. Press Ctrl-G to view the properties for the second text item.

3. In the Text Properties box, click in the To field of the Display Range group and type 5.

4. Click OK to close the Text Properties box.

5. Click File | Print.

6. Click in the To field of the Print Range group of the Print Labels dialog box and type 10.

When the labels are printed, they will look like this:

                  Labels 1-5                                       Labels 6-10

  First text item

          Second text item

  First text item
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Using the Bar Code Item

You can add a bar code to a label.  PAN-MARK supports 21 different bar code symbologies.  Use the Interleaved Code
39 for inventory control or use the 2D Bar Code PDF 417 to convey thousands of bits of information about a piece of
equipment.

We won’t attempt to explain each of the Bar Code symbologies, however, we will show you how to create a bar code in
PAN-MARK  .

To create a Bar Code:

1. Open a new or existing label, then do one of the following:

• Click Item | Dynamic | Bar Code
• Press Ctrl+Shift+B
• Click the Bar Code icon in the Items bar
• Click the right mouse button, then click Bar Code in the pop-up menu

2. Move the Bar Code pointer into the label area.  Place the pointer where you want the Bar Code to appear.

3. Drag the handle until the input area is the size you want.
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4. Release the mouse button.  The Bar Code Properties window appears.

5. In the Symbology Properties box, choose the type of Bar Code.

6. Click the Bar Code Text tab and enter the appropriate information.
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7. Click the Series Properties tab if a serialized bar code is being printed, enter the appropriate information.

8. Click the ODBC Properties tab if you want to import database information.
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9. Click the Preview Tab if you want to preview the bar code before printing or if you want to modify how human
readable text appears in conjunction to the bar code.

10. Click OK and the bar code appears on the label.
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Layout Menu

Use the Layout menu to align, center, and size items in your label.  Remember, items can be text or images.

Aligning Items in a Label

Using the Align command, you can place items at various locations on your label.

1. Select the item.

2. Click Layout | Align, then:

• Click Left to move the item to the left margin
• Click Right to move the item to the right margin
• Click Top to move the item to the top of the label
• Click Bottom to move the item to the bottom of the label

NOTE:  If one item is selected, the item is aligned to the designated label margin.  If more than one item is
selected, items are aligned with the last item selected.

You can also use the Movement Bar to perform these functions.  For more information, see the Movement Bar section
found in the chapter Exploring PAN-MARK.
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Centering Items in a Label

Using the Center command, you can center items horizontally and vertically on your label.

1. Select the item.

2. Click Layout | Center, then:

• Click Horizontal to center the item horizontally
• Click Vertical  to center the item vertically
• Click Both to center the item  horizontally and vertically

You can also use the Movement Bar to perform these functions.  For more information, see the Movement Bar section
in the chapter Exploring PAN-MARK.

Sizing Two or More Items in a Label

Use the Size command to make two or more items in your label the same size.

Click Layout | Size, then:

• Click Width to adjust the width of two or more items
• Click Height to adjust the height of two or more items
• Click Both to adjust the height and width of two or more items

For example, you want to use these boxes (which you have drawn using the Line item feature) for a graphic effect in a
label.  After thinking about it, you decide you want all three to be the same size as the center box.

To size these items:

1. Click to select the left box.

2. Press and hold the Shift key, then click the right box.

3. The last item you select will always be the size reference.  Since you want all three boxes to be the same size as
the middle box, Shift-click it last.
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4. Now click Layout | Size | Both.  Now all the boxes are the same size as the middle box.

Label Menu

Use the Label menu to view the format properties of a label, move to another label, insert or remove a label in a series of
labels, or enter an Operator Prompt.

Viewing the Format Properties of a Label

You may want to verify the format properties of a label to make sure that it suits your intended purpose.  Using the
Properties command, you can view this format information.

NOTE:  If the label is unprotected, you can also edit these parameters.  For more information about editing
formats, see Editing a Label Format found in this chapter.

To view the format properties of a label:

1. From within a label, click Label | Properties.  The Format Properties dialog box displays size information for this
label format.
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2. Click General Info in the panel menu to display general information about the label format.

3. Click Document Info in the panel menu to display the document type for this label format.
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4. Click Font Info to display the font selection for this label format.

5. Click Printer Info to display the type of printer this label format is designed for.
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6. Click Preview to display a page of a sheet of labels using this format.

Moving to Another Label

Using the Move To command, you can move to other labels within a series.  For example, if you are working in label 50
of a 100-label series, you can click Label | Move To, then:

• Click First to move to the first label in the series (label 1)
• Click Previous to move to the previous label in the series (label 49)
• Click Next to move to the next label in the series, (label 51)
• Click Last to move to the last label in the series, (label 100)

NOTE:  You can also use the Movement Bar to perform these functions.  For more information, see the
Movement Bar section in the chapter Exploring PAN-MARK for Windows.
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Inserting a Label into a Series of Labels

You can use the Insert command to insert a label into an existing series of labels.

Note:  This feature cannot be used for labels incorporating serialized items.

For example, if you had a series of five labels and wanted to insert a new label between labels one and two, follow these
steps:

1. Click the Next Label icon in the Movement Bar to move to the second label in the series.

2. Click Label | Insert.

Click the
Next Label

icon

Label 2 of 5
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3. A blank label inserts as the “new” second label, and the series now has a total of six labels.

Removing a Label from a Group of Labels

You can use the Remove command to remove a label from an existing series of labels.

Note:  This feature cannot be used for labels using the series item.

For example, if you had a series of five labels and wanted to remove
label 2, follow these steps:

1. Click the Next Label icon in the Movement Bar to move to the second label in the series.

Note: You can also do this by right clicking on the desired label in the preview.  Jump to that label by left
clicking.

Click the Next
Label icon

Label 2 of 6
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2. Click Label | Remove  to remove label 2.

3. The label is removed from the series.

Label 1 of 4
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Entering an Operator Prompt

If you wish, you can provide a special messageor Operator Promptto the person responsible for printing the labels.
This message pops up on the screen when the operator attempts to print the labels.

To enter an operator prompt:

1. Click Label | Operator Prompt.  The Operator Prompt dialog box displays.

2. Type your message in the box.  If you want additional emphasis, choose one of the symbols listed on the right.

3. After entering your message (and selecting a symbol if desired), click OK to exit the Operator Prompt dialog box.

In the following example, this messagealong with a Stop Signwill display on the screen when the operator
accesses the Print function.

Options Menu

Use the Options menu to:

• Select the unit of measurement for your label

• Turn “Cut Here Mark” for Pipe-Markers on/off

• Access the ODBC Administrator functions

Selecting Units of Measurement

To select the unit of measurement for your label:

Click Options | Units, then click Inches or Millimeters to make your selection.

The ruler lines will display your chosen unit of measurement.
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Using the Cut Here Mark

You can print a “Cut Here Mark” as a guide for cutting between pipe markers.  These cut lines are handy when you want
to print several labels and cut them later.

Note:  This option is designed for pipe markers only and should not be used in label or wire marker modes.

To place these marks between pipe markers:

Click Options | Cut Here Mark (a check mark displays in the menu when the option is active).  Click again to turn
this option off.

Using the ODBC Database Designer

Use the ODBC Database Designer to add, modify, or delete data in a table in a database.  You can also add, update, or
delete a data source.  In addition, you can delete, design/add fields within a table or add, update, delete tables within a
data source.

To add data:

1. With no labels open click Options | ODBC Database Designer.
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2. Select the data source you want to add data to.

3. Select the table you want to add to.

4. Right click to add, update, or delete all entries.

5. Right click on a row member to add, update or delete a field.
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Window Menu

Use this menu to open a new label window, choose the type of label window arrangement you prefer (cascade or tile), or
rearrange your label icons when several labels are open.

Opening a New Window for the Current Label

Use this option to view or work in another label within the current label series.

In the following example, you are working in label 8 of 10 and want to compare it to something in label 1.

Click Window | New Window  and label one of the series appears.
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Rearranging Your Label Windows

If you have several labels open, things can get confusing in the work area.  Rearranging these open label windows can
help you organize your work.

To rearrange your label windows manually:

1. Click in the title area of a label window and drag the label to the new position.

2. Repeat this procedure until your label windows are arranged to your preference.

To rearrange your label windows automatically, do one of the following:

• Click Window | Cascade to arrange your labels in an overlapping stack.
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• Click Window  | Tile to arrange your labels in a vertical stack.

Arranging Label Icons

At times, you may be working in so many labels that keeping all of them open is cumbersome, even using the cascade
or tile arrangement.  To gain working space, you can do two things:

• Click the Maximize button to enlarge the working window

• Click the Minimize button in some of the labels to reduce them to icons

For more information on maximizing or minimizing windows or reducing windows to icons, refer to your
Windows documentation.
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Help Menu

Use this menu to obtain various levels of online help about PAN-MARK.

Click Help, then choose one of the following:

Contents Displays the table of contents for online help

Index Accesses the Index and Find functions.

You can search for a topic in the alphabetic index

       or 

You can find occurrences of a word or words to
narrow the search for a topic

Using Help How to use the on-line help feature

You can get step-by-step instructions on how to find a
topic in Help, copy information from a Help topic, printing
information from a Help topic, and much more...

About PAN-MARK Contains the version and release number for your copy
of PAN-MARK

Contains the serial number for your copy of PAN-
MARK.  This should have been entered upon
installation.
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Chapter 5 - Creating Wire Markers in PAN-MARK 2.5

Introduction to Wire Markers

When labeling wire, an often-used technique is to repeat or “stack” data several times on a label so the information can
be seen easily after the label is wrapped around the wire.

Use PAN-MARK ’s Wire Marker feature to automate this task for you.  Just enter the text or series information you need
and print!

Some notes about Wire Marker Mode:
1.  This feature is designed only for labels using single series and/or legends, such as:

Bldg1-Floor1
Bldg1-Floor2
Bldg1-Floor3

2.  If your wire markers require multiple series or different legends  use Label Mode.
Bldg1-Floor1 Bldg2-Floor1 Bldg3-Floor1
Bldg1-Floor2 Bldg2-Floor2 Bldg3-Floor2
Bldg1-Floor3 Bldg2-Floor3 Bldg3-Floor3

3.  You cannot import data while in Wire Marker mode.
4.  The Movement bar, Alignment bar, and the Zoom bar are disabled when you are in Wire Marker mode.

Text Wire Markers

In this example, you will create text wire markers with part number information.

To create these wire labels:

1. Close all labels.

2. Click the Document Type drop-down arrow and select Wire Marker.
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3. Click the Format drop-down arrow and select PDL-6, a commonly used dot matrix format for wire markers.  (NOTE:
This list of commonly used formats will be different than the list you created in Label Mode.  You may need to select
formats through Format | Select.  If necessary, refer to the section Selecting Your Most Often Used Formats.)

4. Click File, New
 Or 
Press Ctrl+N

 Or 
Click the New icon in the Standard tool bar.  A blank wire marker displays.

5. Click the Text icon in the Items bar.



Creating Wire Markers in PAN-MARK 2.5

124

6. The Text Properties dialog box displays. Type Part# 123456 in the Text area, then click OK.

Your wire marker now displays your “stacked” text information.

The number of repeats on a wire marker is determined by the combination of label size and font size.  For example,
if you change the font size in this wire marker to 8, you get this result.
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Aligning Text in Wire Marker Mode

The default font alignment for wire marker text is centered.  To change this alignment, you use the Font menu.  For
example, to right-justify the previous label text, click Font | Align | Right.

The wire marker text is now right justified.
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Serialized Wire Markers

In this example, you will create 100 serialized wire labels with a format of ABC001, ABC002, etc.

To create these serialized wire markers:

1. Close all labels.

2. Click the Document Type drop-down arrow and select Wire Marker.

3. Click the Label Format drop-down arrow and select PDL-6, a commonly used dot matrix format for wire markers.
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4. Click File, New
 Or 
Press Ctrl+N

 Or 
Click the New icon in the Standard tool bar.  A blank PDL-8 wire marker displays.

5. Click the Series icon in the Items bar.  The Series Properties dialog box displays.

6. Click in the Start Value field and type 001.

7. You want 100 labels, so click in the Stop Value field and type 100.
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8. Click in the Begin String field and type ABC.  Your entries should look like this:

9. Click the OK button to close the Serial Properties dialog box.  Your wire marker now displays your “stacked” serial
information.

The number of repeats on a wire marker is determined by the combination of label and font size.  For example, if you
change the font size in this wire marker to 10, you get this result.
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Chapter 6 - Creating Pipe Markers in PAN-MARK 2.5

Introduction to Pipe Markers

Pipe markers provide a quick and easy way for users to produce single-line, large font labels with symbols in a wide
range of colors and on a variety of materials.

For situations where your information requires more than a single line, use the Label document type.

Labels can be used for many piping situations.  For example,

• At frequent intervals on straight pipe runs
• Changes in direction and at branches
• Close to valves
• Where pipes pass through wall and floors

Pipe markers can be used to:

• Show the direction of flow
• Classify hazardous materials
• Identify fire fighting materials
• Identify the contents or purpose of pipe, such as:

• Waste, recovery, supply, exhaust
• Steam, butane, water, acid
• Sprinkler, roof drain
• Compressed air, blower air, breathable air

PAN-MARK takes the work out of creating these pipe markers. When combined with Panduit’s PTR2E printer, the
process is streamlined even more.
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Creating a Pipe Marker

In this example, you will create a pipe marker for chilled water, with a flow indicator.

The tool bars are disabled when you are in Pipe Marker mode.

To create this pipe marker:

1. Close all labels.

2. Click the Document Type drop-down arrow and select Pipe Marker.

3. Next, you would click the Format drop-down arrow and select the pipe marker format you want to use.  (For this
exercise, we will use PM10UP--which is already selected.)
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If the PM10UP label format is not available from the PAN-MARK window, use the Select option from the Format menu
to add it to the drop-down list in the Document bar.

If necessary, refer to the section Selecting Your Most Often Used Formats found in the chapter Creating Labels in
PAN-MARK 2.5 for more on this procedure.

4. Click File, New
 Or 
Press Ctrl+N

 Or 
Click the New icon in the Standard tool bar.

The Pipe Marker dialog box displays.  (Enlarge the label window if you want to see the entire dialog box.)

5. Type Chilled Water in the Pipe-Marker Text field, then press the Tab key.
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6. Click the Pipe-Marker drop-down arrow and select Right Arrow from the list.

7. Click the Trailing check box, then click the Redraw button.  The directional arrow now displays with the text.

• To increase the distance between the text and image, click the Spaces up arrow, then click Redraw again.  (This
distance is limited by the amount of remaining space available on the pipe marker.)  PAN-MARK limits how far you
can space the image you that it won’t run off the edge.

Cutting Pipe Markers After Printing

Using the razor knife included with your PTR2E printer, cut the printed pipe marker off the roll by running the knife along
the metal label guide.

Exercise CAUTION when cutting labels with the razor knife!

To avoid injury, hold the leading edge of the printed pipe marker away from the printer with one hand, thenholding
the knife with the other handcut the label.
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Appendix

This appendix contains the following:
1. List of Electronic Symbols contained in the PAN-MARK Image Library
2. List of Bar Code Symbologies contained in the PAN-MARK Bar Code Library

The following is a list of Electronic Symbols currently included in the PAN-MARK image library and can be used in label
creation:

Alternating Current Sign
Animals Prohibited
Caution – Biological Hazard
Caution – Corrosive Substance
Caution – Danger of Crushing
Caution - Danger of Hand Injuries
Caution – Drop
Caution – Gas Bottles
Caution – General Warning
Caution – Hot Surface
Caution – Industrial Trucks
Caution – Laser Beam
Caution – Low Temperature
Caution – Milling or Cutting Wheel
Caution – Non-Ionizing Radiation
Caution – Overhead Load
Caution – Oxidizing Materials
Caution – Risk of Electric Shock
Caution – Risk of Explosion
Caution – Risk of Fire
Caution–Risk of Ionizing Radiation
Caution – Slippery Surface
Caution – Starts Automatically
Caution – Strong Magnetic Field
Caution – Toxic Hazard
Caution – Trip Hazard
Caution Sign
Clockwise Sign
Copyright Logo
Counter Clockwise Sign
CSA Logo
Danger of Tilting While Rolling
Data Sign
Directional Arrow #1
Directional Arrow #2
Directional Arrow #3
Do Not Extinguish With Water
Do Not Pull Cable
Do Not Splash With Water
Do Not Throw Switch

Do Not Touch #1
Do Not Touch #2
Do Not Touch High Voltage Cable
Down Arrow
Earth
Eating and Drinking Prohibited
Emergency Exit/Escape Route
Emergency Fire Telephone
Emergency Telephone
Eye/Ear Protection Must Be Worn
Eye Protection Must Be Worn
Eye Wash
Fax Sign
Fire Extinguisher
Fire Hose
First Aid
Foot Protection Must Be Worn
Ground Sign
Hand Protection Must Be Worn
Harmful or Irritant Material
Head/Ear Protection Must Be Worn
Head/Eye Protection Must Be Worn
Head/Respiratory Protection
Head Covering Must Be Worn
Head Protection Must Be Worn
Hearing Protection Must Be Worn
Ladder
Left and Right Arrow
Left Arrow
Microwave Sign
Minus Sign
Mobile Phones Prohibited
No Access For Industrial Vehicles
No Access For Unauthorized Persons
No Extinguish Sign
No Thoroughfare
Not Drinking Water
Pedestrians Must Use This Route
Photography Prohibited
Plus Minus Sign
Plus Sign

Pressurized Gas Bottle
Prohibited - People with Metal Implants
Prohibited – People with Pacemakers
Prohibited – Walk Under Raised Loads
Recycle Sign
Register Logo
Respiratory Protection Must Be Worn
Riding on Fork-Lift Trucks Prohibited
Riding on Pallet Trucks Prohibited
Right Arrow
Safety Overalls Must Be Worn
Safety Shower
Smoking and Naked Flames Prohibited
Smoking Permitted
Smoking Prohibited
Static Hand Sign
Static Sign
Storing and Stowing Prohibited
Stretcher
Trademark Logo
Unlock Sign
Unplug Equipment Before Opening
Up and Down Arrow
Up Arrow
Voice Sign
Voltage Sign
Warning - Arcing or Spark Over Voltage
Warning – Battery Hazard
Warning – Explosive Atmosphere
Warning – Static Sensitive Device
Wash Your Hands
Wear Breathing Equipment
Wear Face Mask
Wear Face Shield
Wear Safety Harness/Belt
Welding and Soldering Prohibited
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The following is the current list of Bar Code Symbologies that can be generated in PAN-MARK.

• Codabar
• Code 128 (A, Auto, B, C)
• Code 39 (Standard, Extended)
• Code 93 (Standard, Extended)
• EAN/JAN 13
• EAN/JAN 8
• HIBC/HIBC-LIC
• Interleaved 2 of 5
• MSI Plessey
• PDF417
• UCC 128
• UPC-A
• UPC-E System 0
• UPC-E System 1
• Zip + 4 Postal Codes


